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1 Introduction

1.1 Add-onModule RF-/STEEL HK

The Code of Practice for the Structural Use of Steel [1] describes the design, analysis and construc-
tion of steel structures relevant to Hong Kong. With the add-on modules RF-STEEL HK (for RFEM)
and STEEL HK (for RSTAB), DLUBAL provides a powerful tool for designing steel members according
to the regulations published by the Building Department of Hong Kong.

In the following, the add-on modules of both main programs are described in one manual and are
referred to as RF-/STEEL HK.

RF-/STEEL HK performs all typical ultimate limit state designs as well as stability and deflection
analyses. In the ultimate limit state design, the add-on module considers the effect of various
loadings. An essential part of the verification is the classification of the cross-sections to be de-
signed into the classes 1 to 4. This way, the limitation of the capacity to withstand stresses as well
as the rotational capacity due to local buckling of cross-section parts is checked. RF-/STEEL HK
determines the c/t-ratios of the cross-section parts subjected to compression and carries out the
classification automatically.

In the stability analyses, you can specify separately for each member or set of members whether
flexural buckling in y- and/or z-direction is possible. You can also define additional lateral restraints
in order to represent the model close to reality. Based on the boundary conditions, RF-/STEEL HK
determines the slenderness ratios and elastic critical buckling loads. The elastic critical moment
for flexural-torsional buckling required for the lateral-torsional buckling analysis is determined
automatically. Optionally, the program takes into account the load application point of transverse
loads, which has a decisive effect on the torsional resistance.

The serviceability limit state represents an important design for structures with slender cross-sec-
tions. Load cases, load combinations and result combinations can be assigned to different design
situations. The limit deflections are preset by the Code, but can be adjusted, if necessary. In addi-
tion, it is possible to specify reference lengths and precambers that are considered accordingly in
the deflection design.

The add-onmodule provides an automatic cross-section optimizationwith the possibility to export
modified cross-sections to RFEM or RSTAB. Separate design cases allow for the flexibility to analyze
individual structural components within complex structures.

Like other add-on modules, RF-/STEEL HK is completely integrated in RFEM and RSTAB. Thus, the
design-relevant input data is preset when you start the add-on module. After the design, you
can use the graphical user interface of the main program to evaluate the results. As they are also
included in the global printout report, the entire verification can be presented in a consistent and
appealing form.

We wish you ease and success with RF-/STEEL HK.

Your DLUBAL team
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1.2 Using theManual

Topics like installation, graphical user interface, results evaluation, and printout are described in
detail in the manuals of the main programs RFEM and RSTAB. The present manual focuses on
typical features of the RF-/STEEL HK add-on module.

The descriptions in this manual follow the sequence and structure of themodule's input and result
windows. In the text, the described buttons are given in square brackets, for example, [View
Mode]. At the same time, they are pictured on the left. Expressions appearing in dialog boxes,
windows, and menus are set in italics to clarify the explanation.

At the end of the manual, you find the index. However, if you don't find what you are looking
for, you can go to the Knowledge Base to find related articles about the steel add-on modules or
consult the FAQs.

1.3 Opening RF-/STEEL HK Add-onModule

RFEM and RSTAB provide the following options to open the RF-/STEEL HK add-on module.

Menu
To start the program on the RFEM or RSTAB menu bar, select

Add-onModules → Design - Steel → RF-/STEEL HK.

Figure 1.1: Menu Add-onModules→Design - Steel→ STEEL HK

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base
https://www.dlubal.com/en-US/support-and-learning/support/faq
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Navigator
To start RF-/STEEL HK in the Data navigator, select

Add-onModules → RF-/STEEL HK.

Figure 1.2: Data navigator: Add-onModules→ RF-STEEL HK
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Panel
If any results from RF-/STEEL HK are already available in the model, you can open the design
module in the panel:

Set the relevant design case in the load case list of the menu bar. Click the [Show Results] button
to display the design criterion graphically on the members.

When the results display is activated, the panel appears showing the [RF-/STEEL HK] button which
you can use to open the add-on module.

Figure 1.3: Panel with [STEEL HK] button



2 Input Data

©DLUBAL SOFTWARE 2021

7

2

2 Input Data
When you start the add-onmodule, a newwindowappears. In thiswindow, a navigator is displayed
on the left, managing the available module windows . The drop-down list above the navigator
contains the design cases (see Chapter 7.1, page 53).

The design-relevant data must be defined in several input windows. The following parameters are
imported automatically when you open RF-/STEEL HK for the first time:

• Members and sets of members

• Load cases, load combinations, and result combinations

• Materials

• Cross-sections

• Buckling lengths

• Internal forces (in background, if calculated)

To select a window, click the corresponding entry in the navigator. To go to the previous or
subsequent module window, use the buttons shown on the left. You can also use the function
keys to select the next [F2] or previous [F3] window.

To save the entered data, click [OK]. Thus, you exit RF-/STEEL HK and return to the main program.
Click [Cancel] to exit the add-on module without saving the new data.

2.1 General Data

In Window 1.1 General Data, you select the members, sets of members, and actions that you want
to design. The three tabs manage the load cases, load combinations, and result combinations for
the ultimate limit state, the serviceability limit state, and the fire protection design.

Figure 2.1: Window 1.1 General Data
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Design of

Figure 2.2: Design of members and sets of members

You can designMembers as well as Sets of members. If you want to design only selected objects,
clear the All check box: Then, you can access the text boxes to enter the numbers of the relevant
members or sets of members. Use the [Delete] button to clear the list of preset numbers. Use the
[Select] button to define objects graphically in the RFEM or RSTAB work window.

When you design a set of members, the program determines the extreme values of the designs of
all members contained in this set of members and takes into account the boundary conditions
due to connected members for stability analyses. The results are shown in the results windows
2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts List by
Set of Members.

To define a new set of members, click the [New] button. The dialog box known from RFEM or
RSTAB appears where you can enter the parameters for the set of members.

Comment

Figure 2.3: User-defined comment

In this text box, you can enter user-defined notes describing, for example, the current design case.

2.1.1 Ultimate Limit State

Figure 2.4: Window 1.1 General Data, tab Ultimate Limit State
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Existing Load Cases and Combinations
This column lists all load cases, load combinations, and result combinations that have been created
in RFEM or RSTAB.

To transfer selected entries to the Selected for Design list on the right, click the button. Al-
ternatively, you can double-click the entries. To transfer the entire list to the right, use the
button.

As common for Windows applications, selecting several load cases is possible by clicking them
one by one while holding down the [Ctrl] key. Thus, you can transfer several load cases at the same
time.

If a load case's number is marked in red such as LC11 or LK12 in Figure 2.4, you cannot design it:
It indicates a load case without load data, or a load case that contains imperfections. A warning
appears if you try to transfer it.

Below the list, several filter options are available. They help you assign the entries sorted by load
case, load combination, or action category. The buttons have the following functions:

Selects all load cases in the list

Inverts selection of load cases

Table 2.1: Buttons in Ultimate Limit State tab

Selected for Design
The column on the right lists the load cases as well as load and result combinations that have
been selected for the design. To remove selected items from the list, click or double-click the
entries. To empty the entire list, click .

Result combination

Designing an enveloping max/min result combination (RC) is faster than designing all contained
load cases and load combinations, but the analysis of a result combination also has disadvantages:
First, the influence of the contained actions is difficult to discern. Second, for the determination
of the elastic critical moment Mcr for lateral-torsional buckling, the envelope of the moment
distributions is analyzed, from which the most unfavorable distribution (max or min) is taken. This
distribution, however, only rarely reflects themoment distribution that is available in the individual
load combinations. Thus, for an RC design, more unfavorable values forMcr are expected, leading
to higher ratios.

Result combinations should be selected for design only in case of dynamic combinations. For
“usual” combinations, it is recommended to use load combinations because here the actual mo-
ment distributions are applied for the determination ofMcr.

In the General tab of the Details dialog box, you can define how result combinations of the ‘OR'
type are handled in the design (see Chapter 3.1.4, page 30).
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2.1.2 Serviceability Limit State

Figure 2.5: Window 1.1 General Data, tab Serviceability Limit State

Existing Load Cases and Combinations
This column lists all load cases and combinations that have been created in RFEM or RSTAB.

Selected for Design
You can add or remove load cases as well as load and result combinations as described in Chap-
ter 2.1.1.

The limit values of the deformations are defined in the Code of Practice [1] Table 5.1. They can be
adjusted for the design situations in the Serviceability tab of the Details dialog box (see Figure 3.3,
page 29) that you open with the [Details] button.

In Window 1.9 Serviceability Data, the reference lengths applying to the deformation analysis are
managed (see Chapter 2.9, page 26).
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2.2 Materials

This module window consists of two parts. The upper part lists all materials created in RFEM or
RSTAB. The Material Properties section shows the properties of the current material, that is, the
table row currently selected in the upper section.

Figure 2.6: Window 1.2 Materials

Materials that won't be used in the design are grayed out. Materials that are not allowed are
highlighted in red. Modified materials are displayed in blue.

Chapter 4.3 of the RFEMmanual, or Chapter 4.2 of the RSTAB manual, describes the material prop-
erties that are used for the determination of the internal forces (Main Properties). The properties of
the materials that are required for the design are also stored in the global material library. These
values are preset (Additional Properties).

To adjust the units and decimal places of the properties and stresses, select on the module menu
Settings → Units and Decimal Places (see Chapter 7.3, page 57).

Material Description
Thematerials defined in RFEM or RSTAB are preset but you canmodify them anytime: Click thema-
terial in column A to activate the box. Then, click the button, or press the function key [F7] to
open the material list.

Figure 2.7: List of materials
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According to the design concept of the Code [1], only materials of the Steel category can be
selected.

After the material transfer, the design-relevantMaterial Properties are updated.

If you change the material description manually and the new entry is already listed in the material
library, RF-/STEEL HK will import the material properties as well.

The material properties are generally not editable in the RF-/STEEL HK add-on module.

Material Library
Many materials are stored in the database. To open the material library, click on the module menu

Edit → Material Library

or use the button shown on the left.

Figure 2.8: Dialog boxMaterial Library

The Steelmaterial category is preset in the Filter section. You can select the desired material grade
from theMaterial to Select list; then you can check the properties in the dialog section below.

Click [OK] or use [ ] to transfer the selected material to Window 1.2 of RF-/STEEL HK.

Chapter 4.3 of the RFEMmanual, or Chapter 4.2 of the RSTAB manual, describes how to filter, add,
or reorganize materials.

In the library, you can also select materials of the categories Cast Iron and Stainless Steel. However,
please check whether these materials are allowed by the design concept of the Code [1].
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2.3 Cross-Sections

This window lists the cross-sections used for the design. In addition, you can specify optimization
parameters.

Figure 2.9: Window 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM or RSTAB are preset together with the assigned material num-
bers.

To modify a cross-section, click the entry in column B. Thus, you set the cell active. Then, open the
cross-section table of the current input field by clicking the [Cross-Section Library] button or the

button at the end of the box. You can also use the function key [F7] (see Figure 2.10).

In this dialog box, you can choose a different cross-section or even a different cross-section table.
If you want to select a completely different cross-section category, click the [Back to Cross-Section
Library] button. Then, the general cross-section library opens.

Chapter 4.13 of the RFEMmanual, or Chapter 4.3 of the RSTAB manual, describes how to select
cross-sections from the library.

You can also enter a new cross-section description directly into the input field in column B. If the
entry is already listed in the database, RF-/STEEL HK will import the cross-section properties. A
modified cross-section is highlighted in blue.
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Figure 2.10: Rolled I-section types of cross-section library

If cross-sections set in RF-/STEEL HK are different from the ones used in RFEM or RSTAB, both
cross-sections are displayed in the graphic to the right. The designs will be performed with the
internal forces from RFEM or RSTAB for the cross-section selected in RF-/STEEL HK.

Cross-Section Type
This column shows the cross-section type that is used for the classification. The cross-sections
referred to in [1], Section 7 must be designed plastically or elastically depending on their class.
Non-typical cross-sections are classified as General and can only be designed elastically, which
means Class 3 or 4.

Max. Design Ratio
This column is displayed only after the calculation. It is intended to be a decision support for the
optimization: Looking at the design ratios and colored relation scales, you can clearly see which
cross-sections are hardly utilized and thus oversized, or extremely stressed and thus undersized.

Optimize
Each cross-section of the library can pass through an optimization process: For the internal forces
from RFEM or RSTAB, the program searches the cross-section that comes as close as possible to a
user-defined maximum ratio that can be defined in the General tab of the Details dialog box (see
Figure 3.4, page 30).

To optimize a cross section, open the drop-down list in column E or F, and select the relevant entry:
From current row or, if available, From favorites ‘Description’. Recommendations for optimizing
cross-sections can be found in Chapter 7.2 on page 55.
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Remark
This column shows remarks in the form of footnotes. They are explained below the cross-section
list.

If the warning Incorrect type of cross-section! appears before calculating, a cross-section is set
which is not listed in the database. This may be a user-defined cross-section or a SHAPE-THIN
cross-section that has not yet been calculated. To select an appropriate cross-section for the design,
click the [Library] button (see description below Figure 2.9).

Member with tapered cross-section
For taperedmemberswith different cross-sections at themember start and end, both cross-section
numbers are shown in two rows, in accordance with the definition in RFEM or RSTAB.

RF-/STEEL HK also designs tapered members, provided that the cross-section at the member's
start has the same number of stress points as the cross-section at the end. Normal stresses, for
example, are determined from the moments of inertia and the centroidal distances of the stress
points. If the cross-sections at the start and end of a tapered member have different numbers of
stress points, the intermediate values cannot be interpolated. The calculation is neither possible
in RFEM or RSTAB nor in RF-/STEEL HK.

The cross-section's stress points including numbering can be checked graphically: Select the
cross-section in Window 1.3, and then click the button. The dialog box shown in Figure 2.11
appears.

Info About Cross-Section
Below the cross-section graphic, you find the [Info] button. Click it to open the Info About Cross-Sec-
tion dialog box where you can see the cross-section properties, stress points and c/t-parts.

Figure 2.11: Dialog box Info About Cross-Section
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The buttons below the cross-section graphic have the following functions:

Button Function

Displays or hides stress points

Displays or hides c/t-parts

Displays or hides numbers of stress points or c/t-parts

Shows details of stress points or c/t-parts (see Figure 2.12)

Displays or hides dimensions of cross-section

Displays or hides principal axes of cross-section

Resets full view of cross-section

Table 2.2: Buttons of cross-section graphic

Use the [Details] buttons to call up specific information about stress points (centroid distances,
statical moments of area, warping ordinates, etc.) and c/t-parts.

Figure 2.12: Dialog box Stress Points of H HW 150x150
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2.4 Intermediate Lateral Restraints

In Window 1.4, you can define lateral intermediate restraints for members. RF-/STEEL HK always
assumes this kindof support to beperpendicular to the cross-section'sminor axis z (see Figure 2.11).
Thus, it is possible to influence the members' effective lengths (only for Lateral and torsional
restraint type) which are important for the stability analyses concerning flexural buckling and
lateral-torsional buckling.

Figure 2.13: Window 1.4 Intermediate Lateral Restraints

In the upper part of the window, you can assign up to nine lateral supports to each member.
The Settings section shows the entry displayed in a column view for the member selected above.

To define the intermediate restraints of a member, select the check box for Lateral Restraints in
column A. With the button you can select the member graphically to activate its row in the
table. When the check box is selected, the other columns become available, and you can enter
the parameters.

In column C, you can define the Number of intermediate restraints. Depending on the setting, you
can access one or more of the following Intermediate Lateral Restraints columns for defining the
x-locations.

When the check box for Relatively (0 ... 1) is selected, you can define the support points by relative
input: The locations of the intermediate supports result from the member length and the relative
distances to the member start. It is also possible to define the distances manually in the table, if
the Relatively (0 ... 1) check box is cleared.
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2.5 Effective Lengths - Members

This module window is subdivided into two parts. The table in the upper part shows summary
information about buckling length factors and equivalent member lengths for buckling and lat-
eral-torsional buckling of all members to be designed. The effective lengths defined in RFEM or
RSTAB are preset. In the Settings section, you can see additional information about the member
whose table row is selected in the upper part.

With the button you can select a member graphically to activate its row in the table.

Changing entries is possible in the table as well as the Settings tree.

Figure 2.14: Window 1.5 Effective Lengths - Members

The effective lengths for buckling about the minor axis z are aligned automatically with Window
1.4 Intermediate Lateral Restraints. If the intermediate supports divide the member into segments
of different lengths, no values are displayed in columns G, K, and L of Window 1.5.

You can enter the effective lengths manually in the table and the Settings tree. You can also define
them graphically in the work window by using the button that becomes active when the cursor
is placed in the text box (see Figure 2.14).

The effective lengths of each member have to be defined manually on the basis of its boundary
conditions.

The Settings tree includes the following parameters:

• Cross-Section

• Length of member

• Buckling Possible for member (corresponds to columns B, E, and H)

• Buckling About Axis y (corresponds to columns C and D)

• Buckling About Axis z z (corresponds to columns F and G)

• Lateral-Torsional Buckling (corresponds to columns I to K)
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For the selected member, you can define whether a buckling or a lateral-torsional buckling analy-
sis is generally to be carried out. In addition, you can adjust the Effective Length Factor for the
respective directions. When changing a factor, the equivalent member length will be adjusted
automatically, and vice versa.

It is also possible to define the effective length of a member in a dialog box that you open with
the button [Select effective length factor]. You can find the button below the table.

Figure 2.15: Dialog box Select Effective Length Factor

For each direction, you can select one of the four Euler buckling modes. You can also set a User-de-
fined effective length factor. If an eigenvalue analysis has been carried out by the RF-STABILITY or
RSBUCK add-on module, it is also possible to define a Bucklingmode for the determination of the
factor.

Buckling Possible
The stability analyses for flexural and lateral-torsional buckling require the ability to absorb com-
pressive forces. Therefore, members for which such an absorption is not possible due to the
member type (for example, tension members, elastic foundations, rigid connections) are excluded
from the outset. The rows are grayed out in the table, and a corresponding note is shown in the
Comment column.

The Buckling Possible check boxes in table row A and in the Settings tree offer a control option for
the stability analyses: They determine if these analyses are performed or omitted for the member.

Buckling About Axis y or Axis z
With the check box in the Possible column, you decide if a member has the risk of buckling about
the axis y and/or z. These axes represent the local member axes, with axis y being the “major” and
axis z the “minor” member axis. The effective length factors Ky and Kz for buckling about themajor
or minor axis can be selected freely.

In Window 1.3 Cross-Sections, you can check the position of the member axes in the cross-section
graphic (see Figure 2.9, page 13). With the [Jump to graphic] button you can also access the RFEM
or RSTAB work window. There, you can display the local member axes by using the member's
shortcut menu or the Display navigator.
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Figure 2.16: Activating the member axis systems in Display navigator of RFEM

If buckling is possible about one or both member axes, you can enter the effective length factors
in columns C and F, and the effective lengths in columns D and G. The same is possible in the
Settings tree.

To define the effective lengths graphically in the work window, use the button that becomes
available when the cursor is placed in a KL text box (see Figure 2.14).

When you specify the effective length factor K, the program determines the effective length KL by
multiplying the member length L by this factor. The K and KL text boxes are interactive.

Lateral-Torsional Buckling Possible
Column H shows which members are included in the analysis of lateral-torsional buckling.

Equivalent UniformMoment Factor mLT

The factor mLT represents the equivalent uniform moment factor for lateral-torsional buckling.
For cantilevers, mLT is equal to 1. The equivalent uniform moment factors for typical moment
distributions are specified in [1] Table 8.4a and Table 8.4b. The list of this column provides an
option for the program to apply this factor automatically according to Table 8.4b. Alternatively, you
can define this factormanually.

Effective Length Factor for LTB KLT

The effective length factor KLT controls the effective length for lateral-torsional buckling according
to [1] 8.3.4. For a beam with its compression flange restrained against lateral movement at the
end supports, but free to rotate on plan and with ends under nominal torsional restraint about
the longitudinal axis of the beam at the end supports, this factor is 1.0. By increasing or reducing
this factor, you can adjust the factor to the boundary conditions of each member.

If the effective length for lateral-torsional buckling KLLT differs from the member length, you can
also define it manually in column K or graphically with the button that appears when you select
a cell. Columns J and K are interactive, i.e. the effective length factor is updated automatically.

Comment
In the final column, you can enter user-defined notes to describe, for example, the equivalent
member lengths.
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Set input for members No.
Below the Settings table, you find the check box Set input for members No. If you select it, the
subsequent settingswill apply toAllmembers or to selectedmembers (enter themember numbers
manually or select them graphically with ). This option is useful if you want to assign the same
boundary conditions to several members (see also DLUBAL article
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000726).

Settings which have already been defined cannot be changed subsequently with this function.

2.6 Effective Lengths - Sets of Members

This window appears when at least one set of members has been set for design inWindow 1.1 Gen-
eral Data.

Figure 2.17: Window 1.6 Effective Lengths - Sets of Members

The concept of this window is similar to the previous Window 1.5 Effective Lengths - Members. Here,
you can enter the effective lengths for buckling about both principal axes of the set of members as
well for lateral-torsional buckling, as described in Chapter 2.5. They define the boundary conditions
of the set of members that is handled in its entirety.
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2.7 Nodal Supports - Sets of Members
This window is displayed if at least one set of members has been selected for design in Window
1.1 General Data.

Figure 2.18: Window 1.7 Nodal Supports - Set of Members

The current table manages the boundary conditions of the set of members that is selected on the
left in the navigator.

The supports defined in RFEM or RSTAB (for example, in Z for a continuous beam) are not relevant
in this window: The distributions of moments and shear forces for the determination of the
amplification factor are automatically imported from RFEM/RSTAB. Here, you define the support
conditions affecting the stability failure (buckling, lateral-torsional buckling).

Supports on the start and end nodes of the set of members are preset. Any other supports, for
example due to connected members, must be added manually. Use the button to select
nodes graphically in the RFEM/RSTAB work window.

To determine the elastic critcal momentMcr, the program creates a planar framework with four
degrees of freedom for each node.

The orientation of the axes in the set ofmembers is important for the nodal support definition. The
program checks the position of the nodes and internally defines the axes of the nodal supports
for Window 1.7 according to Figure 2.19 to 2.22. The [Local Coordinate System] button below the
model graphic can help you with the orientation: Use it to display the set of members in a partial
view where the axes are clearly visible.

Figure 2.19: Auxiliary coordinate system for nodal supports - straight set of members
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If all members of a set of members rest on a straight line, as shown in Figure 2.19, the local
coordinate system of the first member in the set of members corresponds to the equivalent
coordinate system of the entire set of members.

Figure 2.20: Auxiliary coordinate system for nodal supports - set of members in vertical plane

If the members of a set of members do not rest on a straight line, they still have to be located
in the same plane. In Figure 2.20, the members rest in a vertical plane. In this case, the X'-axis is
horizontal and oriented in the direction of the plane. The Y'-axis is horizontal as well and defined
perpendicular to the X'-axis. The Z'-axis is oriented perpendicular downwards.

Figure 2.21: Auxiliary coordinate system for nodal supports - set of members in horizontal plane

If themembers of a buckled set of members rest in a horizontal plane, the X'-axis is defined parallel
to the X-axis of the global coordinate system. Thus, the Y'-axis is oriented in the opposite direction
to the global Z-axis, and the Z'-axis is directed parallel to the global Y-axis.

Figure 2.22: Auxiliary coordinate system for nodal supports - set of members in inclined plane

Figure 2.22 shows the general case of a buckled set of members: The members do not rest on
a straight line, but in an inclined plane. The definition of the X'-axis results from the intersection
line between the inclined and the horizontal plane. Thus, the Y'-axis is perpendicular to the X'-axis
and in vertical position to the inclined plane. The Z'-axis is defined perpendicular to the X'-axis
and Y'-axis.
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The buttons below the graphic have the following functions:

Button Function

Shows model or system sketch

Shows members as 3D rendering or wire-frame model

Shows current set of members or entire model

Displays irrelevant members of model as transparent or opaque

Shows set of members with local coordinate system or entire model

Shows view in direction of X-axis

Shows view in opposite direction of Y-axis

Shows view in direction of Z-axis

Sets isometric view

Table 2.3: Buttons for cross-section graphic

With the [Edit warp stiffener] button it is possible to determine the constant of a warp spring by
the program.

Figure 2.23: Dialog box Edit Warp Spring

The following warp stiffening types are available in the Edit Warp Spring dialog box:

• End plate

• Channel section

• Angle

• Connecting column

• Cantilevered portion

Materials and cross-sections can be selected by using the lists and [Library] buttons. With the
button you can select them also graphically in the RFEM/RSTAB model.

Based on the parameters, RF-/STEEL HK determines the Resulting warp spring Cu� which can then
be imported with [OK] in Window 1.7.
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2.8 Member Hinges - Sets of Members

This window is displayed if at least one set ofmembers is selected for design inWindow 1.1 General
Data. Here, you can define hinges for members within the set of members that, for structural
reasons, don't transfer the degrees of freedom locked in Window 1.7 as internal forces. Make sure
that no double hinges are generated in coaction with Window 1.7.

The table manages the hinge parameters of the set of members selected in the navigator on the
left.

Figure 2.24: Window 1.8 Member Hinges - Set of Members

In column B, you specify theMember Sidewhere the hinge is located, or if there are hinges on both
member sides.

In columns C to F, you can define the releases or spring constants in order to adjust the set of
members model to the support conditions of Window 1.7.
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2.9 Serviceability Parameters

This window controls various settings for the serviceability limit state design. It is displayed if cor-
responding data has been set in the Serviceability Limit State tab of Window 1.1 (see Chapter 2.1.2,
page 10).

Figure 2.25: Window 1.9 Serviceability Data

In column A, you decide whether the deformation refers to single members or sets of members.
For a set ofmembers, it is necessary that a uniformmember orientation and rotation of all included
members is given. Only in this way can the deformation components be determined correctly.

In column B, you enter the numbers of the members or sets of members that you want to design.
You can also use the button to select them graphically in the RFEM/RSTAB work window. Then,
the Reference Length appears automatically in column D. The column presets the lengths of the
members and sets of members. You can adjust the valuesManually after ticking the check box in
column C.

In column E, you define the governing Direction for the deformation analysis. You can select the
directions of the local member axes y and z (or u and v for unsymmetrical cross-sections).

In column F, a Precamber can be taken into account. The precamber's general direction is defined
in the Serviceability tab of the Details dialog box (see Figure 3.3, page 29). If the precamber is
related to the “major” principal axis y or u, the column titlewc,z changes towc,y orwc,u.

For a correct application of limit deformations, the Beam Type is of vital importance. In column G,
you can specify whether a beam or a cantilever is to be designed and which end is free of support.

The setting in the Serviceability tab of the Details dialog box indicates whether the deformations
are related to the undeformed system or to shifted members ends/set of members ends (see
Figure 3.3, page 29).
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3 Calculation

3.1 Detailed Settings

The designs are based on the internal forces determined in RFEM or RSTAB.

Before you start the calculation, it is recommended to check the design details. You can access
the corresponding dialog box in all windows of the add-on module by using the [Details] button.

The Details dialog box has the following tabs:

• Ultimate limit state

• Stability

• Serviceability

• General

3.1.1 Ultimate Limit State

Figure 3.1: Dialog box Details, tab Ultimate Limit State

Options
Cross-sections assigned to class 1 or 2 are designed plastically by RF-/STEEL HK. If this is not desired,
you can activate the Elastic design also for those cross-section classes.
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3.1.2 Stability

Figure 3.2: Dialog box Details, tab Stability

Stability Analysis
The Perform stability analysis check box controls whether to run a stability analysis in addition to
the cross-section designs. If you clear the check box, Windows 1.4 through 1.8 are not displayed.

Determination of Elastic Critical Moment for LTB
For sets ofmembers, RF-/STEELHKdetermines the elastic criticalmoment by an eigenvalue analysis.
For the calculation, the program uses a finite member model to determineMcr taking into account
the following items:

• Dimensions of gross cross-section

• Load type and position of load application point

• Effective distribution of moments

• Lateral restraints (by support conditions)

• Effective boundary conditions

If transverse loads are available, it is important to define the location where these forces are acting
on the cross-section: Depending on the load application, transverse loads can be stabilizing or
destabilizing, and thus have a major impact on the elastic critical moment.

The signs of the eccentricities are related to the cross-section's shear center M. The following
DLUBAL article provides more information about the sign convention for transverse loads:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/000880
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Structure Type
If sway of structural components is relevant, the equivalent uniform moment factor for flexural
buckling about x- and y-axis can be applied in a customary manner.

Limit Values for Special Cases
To design unsymmetrical cross-sections with the intended axial compression according to [1] 8.7,
you can neglect small moments about the major and the minor axis by the settings defined in this
dialog section.

Analogously, it is possible for the pure check of bending according to [1] 8.3 to neglect small
compression forces by defining a limit ratio of Fc / Pc.

The intended Torsion is not clearly specified in [1]. If there is a torsional stress not exceeding
the shear stress ratio of 5% preset by default, it is neglected for the stability design; only results for
flexural and lateral-torsional buckling are displayed.

If one of the limits in this dialog section is exceeded, a note appears in the results window and the
programwon't perform any stability analysis. However, the cross-section designs are performed
independently. These limit settings are not part of the Code [1]. Modifying the limits is the user's
responsibility.

3.1.3 Serviceability

Figure 3.3: Dialog box Details, tab Serviceability
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Serviceability (Deflections)
You can check and adjust, if necessary, themaximum deflection relevant to beams and cantilevers.
The deflection limits recommended by [1] Table 5.1 are preset.

The Deformation relative to options control whether the maximum deflections are related to the
shifted ends of members or sets of members (connection line between start and end nodes of the
deformed system) or to the undeformed initial system. Generally, the deflections are designed
relative to the displacements in the entire structural system.

The following DLUBAL article presents an example describing the relation of deformations.
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001081

3.1.4 General

Figure 3.4: Dialog box Details, tab General

Calculation of Result Combinations with OR Type
If combinations are created automatically, usually many load combinations (CO) are produced.
Generally, these combinations are summarized in a result combination (RC) as alternatively acting
in an ‘OR' connection which provides the envelope: CO1/p or CO2/p or CO3/p or CO4/p etc. For
the design of these result combinations, you have two possibilities in RF-/STEEL HK.

The load components of the contained combinations can be analyzed separately. Thus, the elastic
critical moments for lateral-torsional buckling are determined separately for each constellation,
and the designs are performed accordingly. This approach provides exact results. However, it is
very time-consuming and requires a high computational effort.
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Alternatively, it is possible to Analyze result combinations generally. This calculation runs consider-
ably faster because RF-/STEEL HK uses only the extreme values with the corresponding internal
forces for the design. However, the result may be incorrect if the RC includes a combination where
several internal forces (such as N andMy) are together just below the extreme values.

Cross-Section Optimization
By default, the optimization is targeted on the maximum allowable design ratio of 100%. If neces-
sary, you can set a different design ratio in this text box.

Check of Member Slendernesses
In the two text boxes, you can specify the limit values KL / r in order to define the member slender-
nesses. Separate specifications are possible formemberswith tension forces only and formembers
with compression and flexure. The slenderness ratios recommended by [1] 6.6.4 are preset.

In Window 3.3, the limit values are compared to the real member slendernesses. This window is
available after the calculation (see Chapter 4.8, page 40) if the corresponding check box in the
Display Result Windows section to the right is selected.

Display Result Windows
In this dialog section, you can select which result windows including parts list are displayed. The
windows are described in Chapter 4.

Window 3.3 Member Slendernesses is deactivated by default.
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3.2 Starting the Calculation

In all input windows of the RF-/STEEL HK add-on module, you can start the calculation by clicking
the [Calculation] button.

RF-/STEEL HK searches for the results of the load cases, load combinations and result combinations
to be designed. If they cannot be found, the program starts the RFEM or RSTAB calculation to
determine the design-relevant internal forces.

You can also start the calculation in the RFEM or RSTAB user interface: The To Calculate dialog box
(menu Calculate → To Calculate) lists the design cases of the add-on modules like load cases or
load combinations.

Figure 3.5: Dialog box To Calculate

If the RF-/STEEL HK design cases are missing in the Not Calculated section, select All or Add-on
Modules in the drop-down list below the list.

To transfer the selected RF-/STEEL HK cases to the list on the right, use the button. Then, click
[OK] to start the calculation.

You can also calculate a design case directly by using the list in the toolbar: Set the RF-/STEEL HK
case and click the [Show Results] button.

Figure 3.6: Direct calculation of a STEEL HK design case in RSTAB

Subsequently, you can observe the calculation process in the solver dialog box.
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4 Results
Window 2.1 Design by Load Case appears immediately after the calculation.

Figure 4.1: Result window with designs and intermediate values

The designs are shown in the result windows 2.1 through 2.5, sorted by different criteria.

Windows 3.1 and 3.2 list the governing internal forces; Window 3.3 gives information on member
slendernesses.

Windows 4.1 and 4.2 show the parts lists by members and sets of members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the
previous or next window, use the buttons shown on the left. You can also use the function keys
[F2] and [F3] to go through the windows.

Click [OK] to save the results. Then, you exit RF-/STEEL HK and return to the main program.

Chapter 4 describes the result windows one by one. Evaluating and checking results is described
in Chapter 5, page 43.



4 Results

©DLUBAL SOFTWARE 2021

34

4

4.1 Design by Load Case

The upper part of the window shows a summary of the governing designs, sorted by load case,
load combination, and result combination. In addition, the table is subdivided into ultimate and
serviceability limit state design results.

The lower part includes detailed information on the cross-section properties, analyzed internal
forces, and design parameters for the load case selected above.

Figure 4.2: Window 2.1 Design by Load Case

Description
This column shows the descriptions of the load cases, load and result combinations for which the
designs have been performed.

Member No.
This column shows the number of the member with the maximum design ratio for the designed
action.

Location x
This column shows the respective x-location of the member where the maximum design ratio
occurs. The following member locations x are used for the table output:

• Start and end node

• Division points according to possibly definedmember division (see RFEM table 1.16 or RSTAB
table 1.6)

• Member division according to specification for member results (Calculation Parameters dialog
box of RFEM/RSTAB, Global Calculation Parameters tab)

• Extreme values of internal forces
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Design Ratio
Columns D and E show the design conditions according to [1].

The length of the colored bar represents graphically the respective design ratio.

Design According to Formula
This column displays the Code's equations from which the designs have been performed.

DS
Column G provides information on the design relevant situations (DS): ULS for the ultimate limit
state or SLS for the serviceability limit state design.

4.2 Design by Cross-Section

Figure 4.3: Window 2.2 Design by Cross-Section

In this results window, the maximum design ratios of all members and actions selected for design
are listed by cross-section. The results are sorted by cross-section design and stability analysis as
well as serviceability limit state design.

If there is a tapered member, the cross-sections of the member start and end are listed separately.
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4.3 Design by Set of Members

Figure 4.4: Window 2.3 Design by Set of Members

This results window is displayed if at least one set of members has been selected for design. The
window lists the maximum design ratios sorted by set of members.

TheMember No. column shows the number of the member within the set of members that bears
the maximum ratio for the individual design criteria.

The output by set ofmembers allows you to clearly present the design of an entire structural group
(a frame, for example).
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4.4 Design byMember

Figure 4.5: Window 2.4 Design byMember

This resultswindow shows themaximumdesign ratios for the individual designs sortedbymember
number. The columns are described in detail in Chapter 4.1 on page 34.

4.5 Design by x-Location

Figure 4.6: Window 2.5 Design by x-Location
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This results window lists the maxima for eachmember at all locations x, resulting from the division
points defined in RFEM or RSTAB:

• Start and end node

• Division points according to possibly definedmember division (see RFEM table 1.16 or RSTAB
table 1.6)

• Member division according to specification for member results (Calculation Parameters dialog
box of RFEM/RSTAB, Global Calculation Parameters tab)

• Extreme values of internal forces

4.6 Governing Internal Forces byMember

Figure 4.7: Window 3.1 Governing Internal Forces byMember

For each member, this window displays the governing internal forces, that is, the forces and
moments that result in the maximum utilization in the individual designs.

Location x
This column shows the respective x-location of the member where the maximum design ratio
occurs.

Loading
This column shows the numbers of the load case as well as the load or result combination whose
internal forces result in the maximum design ratio.
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Forces / Moments
For each member, this column displays the axial and shear forces as well as the torsional and
bendingmoments producing themaximum ratios in the respective cross-section designs, stability
analyses, and serviceability limit state designs.

Design According to Formula
The final column gives information on the design types and equations used for performing the
designs according to the Code [1].

4.7 Governing Internal Forces by Set of Members

Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members

For each set of members, this window shows the internal forces that result in the maximum ratios
for the individual designs.
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4.8 Members Slendernesses

Figure 4.9: Window 3.3 Member Slendernesses

This result window is displayed if the corresponding check box is ticked in the General tab of the
Details dialog box (see Figure 3.4, page 30).

The table lists the effective slendernesses of the designed members for both directions of the
principal axes. They have been determined as a function of the load type. Below the list, you see a
comparisonwith the limit values defined in theGeneral tab of theDetails dialog box (see Figure 3.4,
page 30).

Members of the “Tension” or “Cable” type are not displayed in this window.

This window is only of an informative nature. It provides no stability analysis of slendernesses.
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4.9 Parts List byMember

Finally, there is a summary of all cross-sections included in the design case.

Figure 4.10: Window 4.1 Parts List byMember

By default, this list contains only the designed members. If you need a parts list for all members of
the model, you can set it in the General tab of the Details dialog box (see Figure 3.4, page 30).

Part No.
The program assigns part numbers to similar members.

Cross-Section Description
This column lists the cross-section numbers and descriptions.

Number of Members
This column shows howmany similar members are used for each part.

Length
This column shows the respective length of an individual member.

Total Length
The values in this column are the product from the previous two columns.

Surface Area
For each part, the program displays the surface areas relative to the total length. The surface area
is determined from the Surface of the cross-section that can be found in windows 1.3 and 2.1
through 2.5 in the info about cross-section (see Figure 2.11, page 15).
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Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
TheUnitWeight represents the cross-sectionweight relative to the length of onemeter. For tapered
cross-sections, the program averages both cross-section weights.

Weight
The values of this column are determined from the product of the entries in columns C and G.

Total Weight
The final column indicates the total weight of each part.

Sum
At the bottom of the list, you find a summary of the values shown in columns B, D, E, F, and I. The
last row of the Total Weight column shows the required total amount of steel.

4.10 Parts List by Set of Members

Figure 4.11: Window 4.2 Parts List by Set of Members

The last result window is displayed if at least one set of members has been selected for design. It
gives an overview of the steel parts of entire structural groups such as horizontal beams.

The columns are described in the previous chapter. If there are different cross-sections within a
set of members, the program averages the surface area, the volume and the cross-section weight.
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5 Results Evaluation
You can evaluate the design results in different ways. The buttons below the upper table may help
you.

Figure 5.1: Buttons for results evaluation

The buttons have the following functions:

Button Description Function

Ultimate limit state Displays or hides results of ultimate limit state design

Serviceability Displays or hides results of serviceability limit state design

Result combination
Creates a new result combination from governing load cases
and load combinations

Color bars Displays or hides colored relation scales in result windows

Filter parameters
Describes criterion by which results are filtered in tables:
ratios greater than 1, maximum value, or user-defined limit

Apply filter
Shows only rows to which filter parameters apply (ratio > 1,
maximum, defined value)

Result diagrams
Opens Result Diagram onMemberwindow
→ Chapter 5.2, page 47

Excel export
Exports table to MS Excel
→ Chapter 7.4.2, page 58

Select member
Selects a member graphically to display its results in the
table

Viewmode Jumps to RFEM or RSTAB work window to change the view

Table 5.1: Buttons in the result windows 2.1 through 2.5
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5.1 Results on RFEM/RSTABModel

You can evaluate the design results also in the work window of RFEM or RSTAB.

Background graphic and viewmode
The RFEM/RSTAB work window in the background is useful when you want to find the position
of a particular member in the model: The member selected in the result window of RF-/STEEL HK
is highlighted in color in the background graphic. Moreover, an arrow indicates the member's
x-location selected in the active table row.

Figure 5.2: Indication of member and current Location x in RSTAB model

In case you cannot improve the model display by moving the RF-/STEEL HK module window, click
the [Jump to graphic] button to activate the viewmode: The program hides the module window
so that you can adjust the view in the RFEM/RSTAB work window. The view mode provides the
functions of theView menu, for example, zooming, moving, or rotating the model view. The
indicating arrow remains visible.

Click [Back] to return to the RF-/STEEL HK add-on module.

RFEM/RSTABwork window
You can check the design ratios also graphically in the model: Click the [Graphics] button to exit
the design module. In the work window of RFEM or RSTAB, the design ratios are now displayed
like the internal forces of a load case.

In the Results navigator, you can select the design ratios separately for the ultimate and the ser-
viceability limit state design as well as the fire protection design. It is also possible to check the
classifications of cross-sections.
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Figure 5.3: Results navigator for RF-/STEEL HK

To turn on and off the display of design results, click the [Show Results] button that you know from
the display of internal forces in RFEM/RSTAB. Click the [Show Result Values] button to the right to
display the result values.

The RFEM/RSTAB tables are not relevant for the evaluation of the design results.

You can set the design cases in the drop-down list of the RFEM/RSTAB menu bar.

To adjust the graphical representation of results, you can use the Results → Members entry in
the Display navigator. The display of design ratios is Two-Colored by default.

Figure 5.4: Display navigator options for Results→Members
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If you select a multicolor representation (options With/Without Diagram or Cross-Sections), the
color panel becomes available, providing common control functions. The functions are described
in Chapter 3.4.6 of the RFEM or RSTAB manual.

Figure 5.5: Design ratios with display optionWithout Diagram

It is possible to transfer the graphics of design results to the printout report (see Chapter 6.2,
page 51).

To return to the add-on module, click the [RF-/STEEL HK] button in the panel.
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5.2 Result Diagrams

You can also evaluate the member results graphically in the form of result diagrams.

Select the member (or set of members) in the RF-/STEEL HK result window by clicking in the
member's table row. Then, open the Result Diagram onMember dialog box by clicking the button
shown on the left. You can find it below the upper result table (see Figure 5.1, page 43).

To access the result diagrams in the RFEM/RSTAB graphic, select on the menu

Results → Result Diagrams for SelectedMembers

or use the corresponding button in the toolbar of RFEM or RSTAB.

A window opens which shows graphically the distribution of the design values on the member or
set of members.

Figure 5.6: Dialog box Result Diagram onMember

Again, the Results navigator allows for a targeted selection among classifications and the designs
of the ultimate and the serviceability limit state as well as of fire resistance.

Use the list in the toolbar to switch between the RF-/STEEL HK design cases.

The Result DiagramonMember dialog box is described in Chapter 9.5 of the RFEM or RSTABmanual.
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5.3 Filter for Results

The arrangement of the RF-/STEEL HK result windows already provides a selection by vari-
ous criteria. In addition, there are filter options for the tables (see Figure 5.1, page 43) to
limit the numerical output by design ratios. This function is also described in a DLUBAL article:
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000733

Furthermore, you canuse the filter options described inChapter 9.9 of the RFEMmanual, or Chapter
9.7 of the RSTAB manual, to evaluate the results graphically.

The possibilities offered by the Visibility function (see Chapter 9.9.1 in RFEMmanual, or Chapter
9.7.1 in RSTAB manual) are also available for RF-/STEEL HK to filter the members for the evaluation.

Filtering designs
The design ratios can easily be used as filter criteria in the work window of RFEM or RSTAB that
you can access with the [Graphics] button. To apply this function, the panel must be displayed. If
it is not active, select on the RFEM/RSTAB menu

View → Control Panel (Color Scale → Factors → Filter)

or use the toolbar button shown on the left.

The panel is described in Chapter 3.4.6 of the RFEM or RSTAB manual. The filter settings for
the results must be defined in the first panel tab (Color scale). As this tab is not available for
the two-colored results display, you have to set the display options With/Without Diagram or
Cross-Sections in the Display navigator.

Figure 5.7: Filtering design ratios with adjusted color scale

As shown in Figure 5.7, the panel's scale of values can be set in such a way that only design ratios
greater than 0.50 are displayed in a color range between blue and red.
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The function Display Hidden Result Diagram in the Display navigator (Results → Members) shows
all design ratios which are beyond the value spectrum. Those diagrams are represented by dotted
lines.

Filteringmembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
their results filtered. The function is described in Chapter 9.9.3 of the RFEMmanual or in Chapter
9.7.3 of the RSTAB manual.

Figure 5.8: Member filter for design ratios of a hall frame

In contrast to the visibility function, the model will be displayed completely in the graphic. The
figure above shows the design ratios of a hall frame. The remaining members are displayed in
the model but are shown without design ratios.
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6 Printout

6.1 Printout Report

A printout report is generated for the data of the RF-/STEEL HK add-on module, like in RFEM
or RSTAB, to which you can add graphics and descriptions. The selection in the printout report
determines which data from the design module will finally be included in the printout.

The printout report is described in the RFEM or RSTAB manual. Chapter 10.1.3.4 Selecting Data
of Add-on Modules explains how to prepare input and output data of add-on modules for the
printout.

Figure 6.1: Selecting designs and intermediate results in the printout report

Click the [Details] button to specify if the printout also includes intermediate results. They can be
defined in a list and documented in a Short (compact representation) or Long form (list representa-
tion).

For complex structural systemswithmanydesign cases, it is recommended to split data into several
reports, thus allowing for a clearly-arranged printout.
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6.2 Graphic Printout
In RFEM and RSTAB, you can transfer every image displayed in the work window to the printout
report. It is also possible to send it directly to the printer. Thus, the design ratios displayed in the
model can be prepared for the printout, too.

The printing of graphics is described in Chapter 10.2 of the RFEM or RSTAB manual.

Designs in RFEM/RSTABmodel
To print the current graphic of design ratios, select on the menu

File → Print Graphic

or use the toolbar button shown on the left.

Figure 6.2: Print Graphic button in RFEM toolbar

Result diagrams
Also in the Result Diagram onMember dialog box, you can send the graphic with design values to
the report by clicking the [Print] button. Alternatively, you can print it directly.

Figure 6.3: Print button in Result Diagram onMember dialog box

The following dialog box opens:

Figure 6.4: Dialog box Graphic Printout, tab General

The Graphic Printout dialog box is described in Chapter 10.2 of the RFEM or RSTAB manual. There,
you find also descriptions of the other dialog tabs.
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To move a graphic within the printout report to another position, use the drag-and-drop function.

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the report
navigator. The Properties option in the shortcut menu again opens the Graphic Printout dialog box,
offering various options for adjustment.

Figure 6.5: Dialog box Graphic Printout, tab Options
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7 General Functions
This chapter describes useful menu functions as well as export options for the designs.

7.1 Design Cases

Design cases allow you to group members for the designs. This way, you can consider groups
of structural components or analyze members with particular design specifications (for example,
changed materials, partial safety factors, optimization).

It is no problem to analyze the same member or set of members in different design cases.

You can access the design cases of RF-/STEEL HK also in RFEM or RSTAB by using the load case list
of the toolbar.

Create a new design case
To create a new design case, select on the RF-/STEEL HK menu

File → New Case.

The following dialog box appears.

Figure 7.1: Dialog box New STEEL HK Case

In this dialog box, enter a No. (one that is not yet assigned) for the new design case. A Description
will make the selection in the load case list easier.

After clicking [OK], the RF-/STEEL HKWindow 1.1 General Data opens for you to enter the design
data.

Rename a design case
To change the description of a design case, select on the RF-/STEEL HK menu

File → Rename Case.

The following dialog box appears.

Figure 7.2: Dialog box Rename STEEL HK Case

In this dialog box, you can specify a different Description as well as a different No. for the design
case.
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Copy a design case
To copy the input data of the current design case, select on the RF-/STEEL HK menu

File → Copy Case.

The following dialog box appears.

Figure 7.3: Dialog box Copy STEEL HK Case

Define the No. and, if necessary, a Description for the new case.

Delete a design case
To delete a design case, select on the RF-/STEEL HK menu

File → Delete Case.

The following dialog box appears.

Figure 7.4: Dialog box Delete Cases

You can select the design case in the list of Available Cases. To delete the selected case, click [OK].
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7.2 Cross-Section Optimization

The designmodule offers you the possibility to optimize overloaded or little utilized cross-sections:
Define the relevant sections inWindow 1.3 Cross-Sections by opening the drop-down list in column
E or F where you decide if the cross-sections are to be determined From current row or from
user-defined Favorites (see Figure 2.9, page 13). You can also start the optimization in the result
windows by using the shortcut menu.

Figure 7.5: Shortcut menu for cross-section optimization

During the optimization process, RF-/STEEL HK determines the cross-section that fulfills the ul-
timate limit state design in the most “optimal” way, that is, it comes as close as possible to the
maximum allowable design ratio specified in the Details dialog box (see Figure 3.4, page 30). The
required cross-section properties are determined with the internal forces as available from RFEM
or RSTAB. If another cross-section proves to be more favorable, it is used for the design. Then, the
graphic in Window 1.3 shows two cross-sections – the original cross-section from RFEM or RSTAB
and the optimized cross-section (see Figure 7.7).

If you select the Optimize option for a parametric cross-section, the following dialog box appears.

Figure 7.6: Dialog box Thin-Walled Cross-Sections - Symmetric I-Section : Optimize
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You determine the parameter(s) that you want to modify by selecting the Optimize check box(es).
This enables theMinimum andMaximum columnswhere you can define the upper and lower limits
of the parameter. The Increment column controls the interval in which the size of the parameter
varies during the optimization process.

If you want to Keep current side proportions, activate the corresponding check box. In addition, you
have to select at least two parameters for optimization.

Cross-sections composed of rolled cross-sections cannot be optimized.

Please note that during the optimization the internal forces won't be automatically recalculated
with the modified cross-sections: It is up to you to decide which cross-sections should be trans-
ferred to RFEMor RSTAB for recalculation. As a result of optimized cross-sections, the internal forces
may differ significantly because of the modified stiffnesses in the structural system. Therefore, it
is recommended to recalculate the internal forces with the modified cross-sections after the first
optimization, and then to optimize the cross-sections once again.

You can export the modified cross-sections to RFEM or RSTAB: Go to Window 1.3 Cross-Sections
and select on the menu

Edit → Export All Cross-Sections to RFEM/RSTAB.

You can also use the shortcut menu in Window 1.3 to export optimized cross-sections to RFEM or
RSTAB.

Figure 7.7: Shortcut menu in Window 1.3 Cross-Sections

Before the modified cross-sections are transferred, a query appears asking if the results of RFEM or
RSTAB should be deleted.

Figure 7.8: Query before transfer of modified cross-sections to RSTAB
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After starting the [Calculation] in RF-/STEELHK, the internal forces anddesign ratios are determined
in one calculation run.

If the modified cross-sections have not yet been exported to RFEM or RSTAB, you can reimport
the original cross-sections to the design module by using the options shown in Figure 7.7. Please
note that this possibility is only available in Window 1.3 Cross-sections.

If you optimize a tapered member, the programmodifies the member start and end and linearly
interpolates the secondmoments of area for the intermediate locations. Since these moments are
considered with the fourth power, the designs may be inaccurate if the depths of the start and
end cross-section differ considerably. In such a case, it is recommended to divide the taper into
several members, thus modeling the taper layout manually.

7.3 Units and Decimal Places

The units and decimal places are managed for RFEM/RSTAB and the add-onmodules in one dialog
box. In RF-/STEEL HK, you can access this dialog box for adjusting the units by selecting on the
menu

Settings → Units and Decimal Places

The dialog box known from RFEM or RSTAB appears. The RF-/STEEL HK add-on module is preset in
the Program /Module list.

Figure 7.9: Dialog box Units and Decimal Places

The modified settings can be saved as user profile and reused in other models. The functions are
described in Chapter 11.1.3 of the RFEM or RSTAB manual.
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7.4 Data Transfer

7.4.1 ExportingMaterials to RFEM/RSTAB

If the materials have been adjusted in RF-/STEEL HK for the design, you can export the modified
materials to RFEM or RSTAB in a similar way as you export cross-sections: Open Window 1.2
Materials, and then select on the menu

Edit → Export All Materials to RFEM/RSTAB.

You can also use the shortcut menu in Window 1.2 to export materials to RFEM/RSTAB.

Figure 7.10: Shortcut menu of Window 1.2 Materials

Before the modified cross-sections are transferred, a query appears asking if the results of RFEM or
RSTAB should be deleted. After starting the [Calculation] in RF-/STEEL HK, the internal forces and
design ratios are determined in one calculation run.

If the modified materials have not yet been exported to RFEM or RSTAB, you can reimport the
original materials to the design module by using the options shown in Figure 7.10. Please note
that this possibility is only available in Window 1.2 Materials.

7.4.2 Export of Results

The RF-/STEEL HK results can also be used by other programs.

Clipboard
To copy cells selected in the results windows to the clipboard, use the keys [Ctrl]+[C]. To insert them,
for example, in a word processing program, press [Ctrl]+[V]. The headers of the table columns
won't be transferred.

Printout report
The data of RF-/STEEL HK can be printed into the printout report (see Chapter 6.1, page 50) where
they can be exported. Then, in the printout report, select on the menu

File → Export to RTF.

This function is described in Chapter 10.1.11 of the RFEM or RSTAB manual.

Excel/CSV export
RF-/STEEL HK provides a function for directly exporting data to MS Excel or to the CSV file format.
To access this function, select on the menu

File → Export Tables.
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The following export dialog box opens.

Figure 7.11: Dialog box Export of Tables

When you have selected the relevant data, you can start the export with [OK]. Excel will be started
automatically, that is, you do not need to open the programs first.

Figure 7.12: Results in Excel
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